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オペレーティング システム
互換性ツールを使用した旧バージョンOS対応アプリケーションのWindows XP環境への移行プロセス
マイクロソフト株式会社
発行: ２００３年６月１２日
概要

この文書では、Microsoft® Windows® XP 以前のバージョン用に作成されたアプリケーションを、Windows XP 環境に移行するためのプロセスについて説明します。移行するプロセスとして、Windows XP に組み込まれている機能およびツールを使用したアプリケーションのテスト方法から、互換性に関する問題点の解決方法、移行後の環境への修正ファイルの配布までを手順を交えて紹介します。

これは下書きのドキュメントであり、ここで示すソフトウェア製品の最終的な製品出荷に先立ち、大幅に変更することがあります。 

このドキュメントに記載されている情報は、このドキュメントの発行時点におけるマイクロソフトの見解を反映したものです。変化する市場状況に対応する必要があるため、このドキュメントは、マイクロソフトの確約とはみなされないものとします。また、発行以降に発表される情報の正確性に関して、マイクロソフトはいかなる保証もいたしません。

このドキュメントは情報提供のみを目的としています。明示または黙示に関わらず、このドキュメントの情報についてマイクロソフトはいかなる責任も負わないものとします。

お客様ご自身の責任において、適用されるすべての著作権関連法規に従ったご使用を願います。このドキュメントのいかなる部分も、米国 Microsoft Corporation の書面による許諾を受けることなく、その目的を問わず、本書のどの部分も再生可能なシステムに再生、保存、導入したり、いかなる形式または手段（電子的、機械的、写真複写、記録その他）によって転送することを禁止します。ただし、これは、著作権法上のお客様の権利を制限するものではありません。 

マイクロソフトは、このドキュメントに記載されている内容に関し、特許、特許申請、商標、著作権、またはその他の知的財産を有する場合があります。別途マイクロソフトのライセンス契約上に明示の規定のない限り、このドキュメントはこれらの特許、商標、著作権、またはその他の知的財産に関する権利をお客様に許諾するものではありません。

© 2003 Microsoft Corporation.All rights reserved.

Microsoft、Active Directory、Windows は、米国 Microsoft Corporation の米国およびその他の国における登録商標または商標です。
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はじめに

Microsoft® Windows® OS を新しいバージョンに移行すると、既存のアプリケーションに問題が発生してしまう場合がよくあります。しかし、Microsoft Windows XP は従来のアプリケーションを Windows XP 上で正常に動作できるように、アプリケーションの互換性が広くサポートされています。

この文書では、Windows XP 以前のバージョン用に作成されたアプリケーションを、Windows XP 環境に移行するためのプロセスについて、手順を交えて説明します。各プロセスの概要は次のようになります。

· Windows XP 上での動作確認

· 既存アプリケーションを Windows XP 上で実行し、問題点を洗い出します。

· Windows XP に組み込まれている機能を使用した互換性のテスト

· Windows XP に組み込まれている互換性の問題点を解決する機能である [互換性] タブ、およびプログラム互換性ウィザードを使用して、問題点が解決できるかどうかテストします。

· ツール Compatibility Administrator を使用した互換性のテスト

· 互換性の問題を解決するためのツール Compatibility Administrator を使用して、問題点が解決できるかどうかテストします。

· 問題点を修正する互換データベース (.SDB ファイル) の作成と配布

· Compatibility Administrator のテスト結果から、問題の解決に必要なファイルを作成し、他の Windows XP コンピュータに配布します。

アプリケーションの動作確認

まず始めに、Windows XP 上で既存アプリケーションの動作確認を行います。

Windows XP 上でアプリケーションのセットアップから開始し、セットアップ完了後はアプリケーションの機能の動作を確認します。そして、セットアップ中やアプリケーションの動作確認中に発生した問題を洗い出し、互換性のテストの対象にします。

セットアップの動作確認

セットアップにはさまざまな形態がありますが、SETUP.EXE などの一般的なセットアップ プログラムの場合、次のような原因でセットアップが続行できない可能性が考えられます。

· セットアップ プログラムに OS のバージョンチェックがあり、Windows XP のバージョンでは実行が拒否されてしまう。

· ディスクの空き容量のチェックで古い Win32 API が使用され、十分な空き容量 (約2GB以上) があるにもかかわらず、予期しない値が返され、容量不足と判断されてしまう。

アプリケーションの機能の動作確認

セットアップが実行できた場合は、次にアプリケーションの機能について動作確認を行います。アプリケーションの機能の動作確認は、使用頻度などにより機能の重要度をいくつかのレベルに分け、最も重要度の高い機能から行うとよいでしょう。

まずは、最も重要な機能を確認し、正しく動作する場合は続いて次のレベルの機能を確認します。問題が発生した場合は、同じレベルの機能まで動作確認を行い、次のレベルは行わない方がよいでしょう。次のレベルの確認は、この後のテストで既存の問題点が解決された場合に行います。また、アプリケーションのテスト項目書に当たる文書が存在する場合は、動作確認時に利用すると良いでしょう。

すべてのアプリケーションの動作確認が終了したら、次のプロセスに進むかどうか判断します。問題が発生したアプリケーションは次のプロセスに進み、互換性のテストを行います。正しく動作したアプリケーションは、Windows XP と互換性のあるアプリケーションと判断し、ここでテストを終了します。

互換性タブおよびプログラム互換性ウィザードを使用したテスト

アプリケーションの問題点の洗い出しが終了したら、次にそれらの問題点が解決可能かどうかテストを行います。

ここでは、アプリケーションに含まれる互換性の問題点に対して、Windows XP に組み込まれている機能の [互換性] タブ、およびプログラム互換性ウィザードを使用してテストする方法を説明します。

注意
この機能を使用したテストの対象は、スタンドアロンのコンピュータや、ユーザーが個人的に使用しているアプリケーションなど、1 台のコンピュータでのみ使用するアプリケーションです。複数のコンピュータで使用するアプリケーションの場合は、次の章 『Compatibility Administrator を使用したテスト』 のテストを行ってください。

[互換性] タブは、アプリケーション ファイル (.EXE, .BAT など) のアプリケーションのプロパティに表示されるタブの 1 つで、アプリケーションのファイルに手動で互換性に関するプロパティを設定できる機能です。

このプロパティでは、さまざまなモード (環境)、さまざまな設定を選択し、簡単にテストすることができます。たとえば、アプリケーションが本来 Windows 95 で動作するように作成されたものであれば、モードを Windows 95 に設定し、アプリケーションをテストします。モードの他に、画面の表示を 256 色に、解像度を 640 x 480 ピクセルに切り替えるなど、さまざまな設定をテストすることができます。

プログラム互換性ウィザードは、[互換性] タブの設定をウィザード形式で設定できる機能であり、Windows XP のヘルプとサポート センターに組み込まれています。ウィザードの指示に従い、テスト対象のアプリケーションや設定値を選択することで、指定したアプリケーションの [互換性] タブに自動的に設定されます。

[互換性] タブおよびプログラム互換性ウィザードの使用方法を以下に示します。

互換性タブの使用方法

2. エクスプローラから、テスト対象のアプリケーションのファイルを選択し、右クリックのメニューから [プロパティ] を選択し、表示されたプロパティの [互換性] タブを表示します。

[image: image1.png]& Compatibility Demo
TNE RED BRIAD®  Y-AD

Q= - ©Q @ Pu= [

K@
BT~ L THET@),
SOEE

demasphp L pr .
demoapphle, D= 422 ~PA B0
ke 0

demozppitit YA @
FEAR Frauh
ks

“ ge‘rgand”d\\
Compatibility Dema L{ AHOXEW





3. [互換モード] の [互換モードでこのプログラムを実行する] のチェック ボックスを有効にし、アプリケーションが正しく動作する Windows のバージョンをドロップダウンから選択します。たとえば、アプリケーションが Windows 98 で動作するように作成されたものであれば、"Windows 98 / Windows Me" を選択します。
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4. [OK] をクリックして現在の設定を有効にし、プロパティのダイアログを閉じます。アプリケーションが複数のプログラム ファイルで構成されている場合は、そのすべてのファイルに対して手順 1 から 3 を繰り返します。

これで互換性のプロパティが設定されたので、アプリケーションを再度実行して動作を確認します。実行する場合は、スタート メニューやショートカットなど、通常のアプリケーションの起動方法で実行できます。ファイルのアイコンから直接実行する必要はありません。

プロパティで設定可能なもう1つの項目 [ディスプレイ設定] は、単独でも [互換モード] と組み合わせても使用できます。使用する場合は以下の表 1を参考にして下さい。

表 1　[ディスプレイの設定]のヒント
	設定項目名
	予想される問題点の現象

	256 色で実行する
	アプリケーションから返されるメッセージなどから、256 色 (8 ビット) が必要であると考えられる場合

	640 x 480 の解像度で実行する
	アプリケーションが 640 x 480 ピクセルのウィンドウで起動されてしまい、最大化表示ができない場合

	視覚テーマを無効にする
	アプリケーションのダイアログボックスが表示しきれない場合、ボタンがオーバーラップしてしまう場合など、問題点の原因が Windows XP のテーマによるものと考えられる場合


[互換性] タブによる設定は、設定を解除するか、または対象のアプリケーションを削除または再インストールするまで有効です。

プログラム互換性ウィザードの使用方法

注意
対象のアプリケーションが、いくつかのファイル (EXE など) が連動して動作するような、複数のファイルで構成されるアプリケーションの場合は、プログラム互換性ウィザードも使用できますが、[互換性] タブを使用したテストをお勧めします。[互換性] タブは、互換性プロパティの設定後、手動でアプリケーションを実行できますが、プログラム互換性ウィザードの場合は、1つのファイルの設定に1回のテスト実行が含まれるため、すべてのファイルの設定が完了する前に不要なテスト実行が何度か発生してしまうことになります。

5. [スタート] > [すべてのプログラム] > [アクセサリ] > [プログラム互換性ウィザード] をクリックし、プログラム互換性ウィザードを起動します。ウィザードを開始するために、[次へ] をクリックします。
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6. 対象のアプリケーションの指定方法を選択し、[次へ] をクリックします。
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7. 対象のアプリケーションを入力または選択し、[次へ] をクリックします。以下は手順 2 で [手動でプログラムの場所を特定する] オプションを指定した場合の画面例です。

[image: image5.png]D AnTESR—b 5~

TOISLEBED A —F

EOTOIFLEEBRORETEITLEIN?

I3 LOY3- by PRI R 7 b ADHAEA LET O
[cHProgan FieskConpatbily DencHienaappoce





注意
[手動でプログラムの場所を特定する] を使用する場合、通常はアプリケーションのファイル (.EXE など) を指定しますが、アプリケーションへのショートカット (.lnk) を指定することもできます。特に、アプリケーションの起動にコマンド ラインが必要な場合はショートカットを指定します。詳細は次の 『ショートカットを使用して、コマンド ラインを指定してアプリケーションを起動する場合の例』 を参照してください。

ショートカットを使用して、コマンド ラインを指定してアプリケーションを起動する場合の例

Application Compatibility Toolkit 3.0 付属のサンプルアプリケーションdemoapp.exe の場合、指定するコマンド ラインにより起動モードが変化します。

A) コマンド ラインを使用しない場合、セットアップのデモ (Setup モード) が起動する。
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B) コマンド ライン (-runapp) を使用した場合、アプリケーションのデモが起動する。

ショートカットのプロパティにコマンド ライン –runapp を設定した状態で、ショートカットから demoapp.exe を起動する。
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コマンド ラインを指定したことにより、以下のようにアプリケーションのデモ (Main モード) が起動する。
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上記の B の状態に対して互換性をテストする場合、この手順3ではショートカットを指定する必要があります。

ヒント
サンプルアプリケーション demoapp.exe には複数の互換性の問題点が含まれています。詳細については、”Application Compatibility Toolkit 3.0 インストールフォルダ\Applications\Compatibility Administrator” にある demoapp.txt に説明がありますので参考にして下さい。

8. 次に、アプリケーションに適用する互換モードを選択します。適用しない場合は [互換性モードを適用しない] を選択します。選択したら [次へ] をクリックします。
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9. 次に、アプリケーションに適用するディスプレイの設定を選択します。適用する項目のチェックボックスを有効にします。これは複数選択することも、何も選択しないことも可能です。選択する場合のヒントについては、前述の表 1 [ディスプレイ設定] のヒントを参照してください。選択したら、[次へ] をクリックします。

[image: image10.png]D AnTESR—b 5~

TOISLEBED A —F

FIFHOT (AT LA OREERRLES

OISR HELRT OIS LETER R N
O 6 2@

[ 640 « 490 BEAFEES)

HET—TERINCIBO)
BT Widows X BIE007005LOR TR FEESSTHIEOBSNT —7E

B CNA0ATY AL B F ol SIS LOBREINGT, TSI b,
A M TEROES. CoR-TeiiTe BRI S LB RTINS,





10. ウィザードで設定した値が表示されるので、設定内容を確認し、良ければ [次へ] をクリックします。すると、設定内容が適用された状態でアプリケーションが実行されるので、正しく動作するかどうか確認します。動作確認が終了したら、アプリケーションを終了します。
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11. 起動されたアプリケーションを終了すると、ウィザードに戻り、現在の設定の使用について選択します。[はい、このプログラムが常にこれらの互換性の設定を使用するように設定します] の場合、設定値が指定したアプリケーションのプロパティの [互換性] タブに自動的に設定されます。[いいえ、別の互換性の設定を試します] の場合は、手順 4 に戻ります。[いいえ、互換性の設定を完了します] の場合は、ウィザードを終了します。いずれかを選択し、[次へ] をクリックしウィザードを終了します。
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プログラム互換性ウィザードによる設定は、[互換性] タブと同様に設定を解除するか、または対象のアプリケーションを削除または再インストールするまで有効です。また設定の解除は、[互換性] タブから手動で行うことも、ウィザードから行うことも可能です。

[互換性] タブおよびプログラム互換性ウィザードを使用したテストの終了

[互換性] タブおよびプログラム互換性ウィザードを使用した結果、アプリケーションの問題点が解決された場合は、互換性プロパティの設定を適用した状態で、再びアプリケーションの全体の機能について動作確認を行います。

その結果、すべての問題点が解決されアプリケーションが正しく動作する場合はここでテストを終了します。また、残った問題点が日常の業務に支障がない程度である場合は、テスト終了と判断してもよいでしょう。

すべておよび一部の問題点が解決されない場合は、次のテスト 『Compatibility Administrator を使用したテスト』 に進みます。

Compatibility Administrator を使用したテスト

ここでは、アプリケーションに含まれる互換性の問題点に対して、Application Compatibility Toolkit 3.0 に含まれる Compatibility Administrator を使用して解決できるかどうかテストする方法を説明します。

Compatibility Administrator は、Windows XP 上におけるアプリケーションの互換性に関する問題点の解決に役立つツールです。前の章 『互換性タブおよびプログラム互換性ウィザードを使用したテスト』 にあるテストを、より細かく的確にテストすることができます。

このツールでは約 200 の互換性 FIX を使用することができます。互換性 FIX は、Windows XP の互換性の問題点を解決するために用意されたフィックスであり、この互換性 FIX を自由に選択してアプリケーションに適用することができるため、[互換性] タブと比べてより柔軟なテストが可能です。

このツールにはさまざまな機能がありますが、ここではアプリケーションのテストに使用する機能を説明します。Compatibility Administrator の詳細については、Compatibility Administrator に付属のヘルプを参照してください。

Compatibility Administrator を使用したテスト手順を以下の3つのプロセスに分けて説明します。

· テストのための準備

· 互換モードを使用したテスト

· 互換性 FIX を使用したテスト

注意
Compatibility Administrator を使用する場合は、コンピュータの管理者である必要があります。制限ユーザーの場合はツールの機能が限定されてしまい、正しくテストできません。

テストのための準備

テストする際に、Compatibility Administrator 上で同じ操作をする手間を省くため、始めにテストで使用するための互換データベースを作成し、ファイルに保存しておきます。この互換データベースには、アプリケーションに適用する互換モードや互換性 FIX の情報を保存することができます。

この手順を以下の 2 つに分けて説明します。

· .SDB ファイルの作成

· 作成した .SDB ファイルへアプリケーションの情報を追加

.SDB ファイルの作成

まず、互換データベースを保存する .SDBファイルを作成します。.SDB ファイルを作成するには、以下の手順で行います。

12. [スタート] > [すべてのプログラム] > [Microsoft Windows Application Compatibility Toolkit] > [Compatibility Administrator Tool 3.0] をクリックして、Compatibility Administrator を起動します。

13. 左側のペインの [Custom Database] ノードの [New Database] をクリックします。[New Database] が存在しない場合は、ツールバーの [New] をクリック、または [File] > [New] をクリックして作成します。
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14. [New Database] を右クリックし、[Rename] (または [Edit] メニューの [Rename]) をクリックして 、任意のデータベース名に変更します。
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15. ツールバーの [Save] をクリック、または [File] メニューの [Save] をクリックして、名前をつけて .SDB ファイルを保存します(ここでは仮に MyDb.sdb とします)。これで .SDB ファイルが作成されました。
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作成した .SDB ファイルへアプリケーションの情報を追加

次に、作成した .SDB ファイルに対象のアプリケーションの情報を追加します。以下に手順を示します。

16. ツールバーの [Fix] をクリックします。または [Database] メニューの [Create New] をポイントし、 [Application Fix] をクリックします。
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17. [Create new Application Fix] ダイアログが表示されます。ここに、アプリケーション名、ベンダー名、対象となるアプリケーションのファイル名を入力します。[Browse] をクリックしてファイルを参照することも可能です。ここでは [Browse] をクリックして ”C:\Program File\Compatibility Demo\demoapp.exe” を参照します。 [次へ] をクリックします。
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18. 適用する互換モードをクリックします。ここでは、テストのために一時的にファイルを作成できるようにするため、”None” 以外のいずれかを選択し、[次へ] をクリックします。
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19. [Compatibility Fixes] のページが表示されます。ここでは何もせずに [次へ] をクリックします。
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20. [Matching Information] のページが表示されます。ここでは何もせずに [完了] をクリックし、[Create new Application Fix] ダイアログを終了します。
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21. ツールバーの [Save] をクリック、または [File] メニューの [Save] をクリックして、変更を保存します。これで .SDB ファイルに互換データベースが追加され、テスト用の互換データベースが作成されました。
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注意
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アプリケーションが複数の実行ファイルで構成されている場合は、同じ .SDB ファイルに対して手順 1 から 6 を繰り返し、アプリケーションを構成するすべてのファイルを .SDB ファイルに追加します。

以上でテストの準備は完了です。次にこの作成した .SDB ファイルを使用してテストを行います。

互換モードを使用したテスト

Compatibility Administrator で使用する互換モードは、前の章 『互換性タブおよびプログラム互換性ウィザードを使用したテスト』 で使用している [互換性] タブとよく似ています。互換モードは互換性 FIX の集合であり、このツール上から各互換モードに含まれるすべての互換性 FIX を確認することができ、また必要に応じて互換モードに含まれる互換性 FIX を追加/削除するなど、互換モードをカスタマイズすることもできます。

以下に互換モードのテスト手順を説明しますが、対象のアプリケーションが 1 つのファイルで構成されている場合と、複数のファイルで構成されている場合で手順に少し違いがあるため、それぞれのテスト手順について次の 2 つに分けて説明します。

· アプリケーションが 1 つのファイルで構成されている場合

· アプリケーションが複数のファイルで構成されている場合

互換モードのテスト手順 (アプリケーションが 1 つのファイルで構成されている場合)

以下にアプリケーションが 1 つのファイルで構成されている場合の互換モードのテスト手順を示します。テストでは前述の 『テストのための準備』 で作成した互換データベースの .SDB ファイルを使用します。

22. Compatibility Administrator を起動し、ツールバーの [Open] (または、[File] > [Open]) をクリックして、テスト用に作成した互換データベースファイルを開きます。
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23. 左側のペインのアプリケーション名を選択し、右側のペインのアプリケーションのファイル名を右クリックし、[Edit Application Fix] をクリックします。
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24. [Edit Application Fix] ダイアログが表示されます。[次へ] をクリックします。
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25. [Compatibility Modes] のページが表示されます。ここで、アプリケーションに適用する互換モードを選択し、テストすることができます。[Operating System Modes] からアプリケーションが正しく動作する Windows のバージョンを選択します。たとえば、アプリケーションが Windows 95 で動作するように作成されたものであれば、"Microsoft Windows 95" を選択します。互換モードを選択したら、[Test Run] を実行します。
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ヒント
[Select additional compatibility modes] にある互換モードは、単独でも [Operating System Modes] と組み合わせても使用することができます。各互換モードの概要については以下の表 2を参考にしてください。

表 2　互換モード
	互換モード
	説明

	Microsoft Windows 95
	最も一般的な Windows 95 の互換性の問題を解決します。

	Microsoft Windows NT 4.0 (SP5)
	Windows NT Server 4.0 Service Pack 5 用のバージョン情報を返します。

	Microsoft Windows 98 / ME
	最も一般的な Windows 98 および Windows Millennium Edition の互換性の問題を解決します。

	Microsoft Windows 2000
	Windows 2000 用のバージョン信用を返します。

	256Color
	画面を 256 色に設定します。ゲームや教育用のソフトウェアに有効です。

	640 x 480
	解像度を 640 x 480 ピクセルに設定します。ゲームや教育用のソフトウェアに有効です。

	Disable Themes
	Windows XP Professional または Windows Server 2003 の視覚テーマを無効にします。

	International
	2 バイト文字セットを処理します。

	LUA
	アクセス権限が不十分な制限ユーザーからのファイル システムおよびレジストリへの書込み要求を、制限のないエリアにリダイレクトします。セキュリティが関連するユーザー アカウントを導入していない Windows  バージョン用のアプリケーションに有効です。

	ProfilesSetup
	現在のユーザーだけではなく、コンピュータのすべてのユーザーに対してアプリケーションをインストールします。


26.  [Test run application] ダイアログが表示されるので、[Program] ボックスに正しくアプリケーションのファイルが表示されていることを確認し、[OK] をクリックしテストを実行します。他の互換モードを試す場合は手順4で選択するモードを変更し、テストを繰り返します。
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注意
[Program] ボックスにアプリケーションのファイルのパスが正しく指定されていない場合は、[OK] を実行できません。その場合は、[Browse] をクリックして、アプリケーションのファイルを再度指定してください。
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注意
アプリケーションがコマンド ラインを必要とする場合は、[Command line] ボックスにコマンド ラインを入力します。たとえば、Application Compatibility Toolkit 3.0 付属のサンプルアプリケーション demoapp.exe にコマンド ライン “-runapp” を指定して実行する場合は次のように入力します。

ダイアログはこのページ以降も続きますが、この手順では互換モードのみでテストを行うため、ここでテストを終了します。[キャンセル] をクリックしてダイアログを閉じます。

互換モードのテスト手順 (アプリケーションが複数のファイルで構成されている場合)

以下にアプリケーションが複数のファイルで構成されている場合の互換モードのテスト手順を示します。テストでは前述の 『テストのための準備』 で作成した互換データベースの .SDB ファイルを使用します。

27. Compatibility Administrator を起動し、ツールバーの [Open] (または、[File] > [Open]) をクリックして、テスト用に作成した複数のアプリケーションが含まれている互換データベースファイルを開きます。
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28. 全てのアプリケーションのファイルに対して、テストを行う互換モードを設定します。左側のペインのアプリケーションを選択し、右側のペインのアプリケーションのファイルを右クリックし、[Edit Application Fix] をクリックします。
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29. [Edit Application Box] ダイアログが表示されます。[次へ] をクリックします。
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30. [Compatibility Modes] のページが表示されます。ここで、アプリケーションに適用する互換モードを選択し、テストすることができます。[Operating System Modes] からアプリケーションが正しく動作する Windows のバージョンを選択します。互換モードを選択したら [完了] をクリックし、ここでダイアログを終了します。
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ヒント

[Select additional compatibility modes] にある互換モードは、単独でも [Operating System Modes] と組み合わせても使用することができます。各互換モードの概要については前出の表 2を参照してください。

31. アプリケーションを構成するすべてのファイルに対して手順 2 から 4 を繰り返し、すべて同じ互換モードを適用します。

32. すべてのファイルに対して互換モードの適用が終了したら、[Save] をクリックして現在の互換データベースの状態を .SDB ファイルに保存します。その後、互換データベースを右クリックし、[Install] をクリックして互換データベースをインストールします。

[image: image31.png]B3 Compatibility Administrator - MyDb [C ity Demo\MyDB.
Ele Edt Vew Datwbase Search tep

e Do e W ) [@rose M| Oseen S amy
= 4 System Database

&) Applications

@@ Compatbitty Fxes

5 [2] Compatbitty Modes
5 §5) Intaled Databases

{3 Appicaton Verfir Database

[tion about Compatibiity Administrator:

lest version of the Application Compatbiity Tookkt





33. インストールが成功すると以下のメッセージが表示され、左側のペインの [Installed Databases] のノードにインストールした互換データベースが追加されます。
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34. 互換データベースがインストールされたことを確認したら、実際にアプリケーションを起動しテストを行います。アプリケーションの各ファイルは、[スタート メニュー] やショートカットなど、通常と同じ方法で起動してテストを行います。ツール上から [Test Run] や [Run] を使用して起動する必要は特にありません。

35. 別の互換モードをテストする場合は、手順 2 から 6 を繰り返します。ただし、アプリケーションを構成するすべてのファイルに対して同じ互換モードを適用することに注意してください。

ヒント

すべてのファイルの互換モードを変更して、再び互換データベースをインストールする場合は、手順 7 に見られるようなインストール済みの互換データベースをアンインストールする必要はありません。手順 6 でインストールを行うと、インストール済みの互換データベースが更新されます。

互換モードを使用したテストの終了

互換モードを使用してテストした結果、アプリケーションの問題点が解決されない場合は、次に 『互換性 FIX を使用したテスト』 に進み、互換性 FIX を使用したテストを行います。アプリケーションの問題点が解決された場合は、次の 『互換モードのカスタマイズ方法』 に進み、互換モードをカスタマイズします。

互換モードのカスタマイズ方法

ほとんどの互換モードには複数の互換性 FIX が含まれています。このため、アプリケーションに適用した互換モードに必要のない互換性 FIX が存在することが原因で、アプリケーションのパフォーマンスが低下してしまうなどの新たな問題点が発生する可能性があります。ここでは、Compatibility Administrator のログファイルを使用して互換モードに含まれる互換性 FIX をカスタマイズし、最適化する方法を説明します。

注意
Compatibility Administrator のログファイルには、アプリケーションの [Test Run] 実行中に適用された互換性 FIX が記録されます。そのため、[Test Run] の実行ではアプリケーションで動作確認の必要な機能すべてを実行する必要があります。動作確認に不足がある場合、必要な互換性 FIX がログファイルに記録されず、正しく特定できない可能性があります。

36. Compatibility Administrator を起動し、『互換モードのテスト手順』 の手順 1 から 4 までを行います。カスタマイズを行う互換モードを選択して [Test Run] を実行し、アプリケーションで動作確認の必要な機能すべてを実行します。

37. テストが終了したら、[キャンセル] をクリックして [Edit Application Fix] ダイアログを終了します。

38. [View] > [View Log] をクリックし、ログファイル CompatAdmin.log を表示します。
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このログファイルには、Compatibility Administrator 上から実行されたアプリケーションに対して、実際に適用された互換性 FIX が記録されます。たとえば、以下のログファイルの例の場合は、EmulateHeap、MapMemoryB0000、EmulateGetCommandLine、Win95VersionLie の 4 つの互換性 FIX が適用されていることがわかります。

-------------------------------------------

 Log  "C:\Program Files\Compatibility Demo\demoapp.exe"

-------------------------------------------
05/26/2003 21:22:02 EmulateHeap 3 - [NotifyFn] Win9x heap manager initialized

05/26/2003 21:22:02 MapMemoryB0000 3 - [NotifyFn] Created block at 0xB0000.

05/26/2003 21:22:02 EmulateGetCommandLine 1 - [GetCommandLineA] Changed Command Line from <"C:\Program Files\Compatibility Demo\demoapp.exe" > to <C:\PROGRA~1\COMPAT~1\demoapp.exe >.

05/26/2003 21:22:02 Win95VersionLie 3 - [GetVersionExA] Return Win95

05/26/2003 21:22:02 EmulateGetCommandLine 1 - [GetModuleFileNameA] Changed <C:\Program Files\Compatibility Demo\demoapp.exe> to <C:\PROGRA~1\COMPAT~1\demoapp.exe>.

05/26/2003 21:22:02 EmulateGetCommandLine 1 - [GetModuleFileNameA] Changed <C:\Program Files\Compatibility Demo\demoapp.exe> to <C:\PROGRA~1\COMPAT~1\demoapp.exe>.

05/26/2003 21:22:02 Win95VersionLie 3 - [GetVersionExA] Return Win95

39. 05/26/2003 21:22:09 Win95VersionLie 3 - [GetVersionExA] Return Win95
40. ログファイルに記録されていない互換性 FIX を互換モードから削除します。互換データベースから対象のアプリケーションを右クリックして、[Edit Application Fix] をクリックし、[Edit Application Fix] ダイアログを表示します。
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41. [次へ] をクリックし、[Compatibility Modes] のページでカスタマイズを行う互換モードを選択して [次へ] をクリックします。
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42. [Compatibility Fixes] のページで、不要な互換性 FIX を削除します。互換性 FIX の選択が終了したら、再び [Test Run] を実行して、アプリケーションの動作確認を行います。互換モードのカスタマイズ前と同様に問題点が修正されていること、またログファイルに現在選択中の互換性 FIX がすべて記録されていることを確認できたらカスタマイズを終了します。

注意

互換モードをカスタマイズした結果、アプリケーションに再び問題が発生する場合は、互換性 FIX を数回に分けて削除して問題の発生しない境界を明確にするか、または互換モードをカスタマイズせずにそのまま使用します。
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ヒント
[Show Selected] をクリックすると、現在選択中の互換性 FIX のみの表示に切り替えられ、互換性 FIX の追加および削除がしやすくなります。

[Show Selected] をクリックして、選択中の互換性 FIX のみ表示している場合

43. アプリケーションに必要な互換性 FIX が明確になりカスタマイズが終了したら、[次へ] をクリックして [Matching Information] のページで [完了] をクリックしてダイアログを閉じ、カスタマイズした互換モードを保存します。互換性 FIX が正しく選択されているかどうか確認するには、右のペインのアプリケーションファイル名のノードにある [Compatibility Fixes] を確認します。
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ヒント
手動で選択した互換性 FIX をまとめてカスタムの互換モードを作成することもできます。作成方法は、Compatibility Administrator Help の [Compatibility Administrator Overview] – [Working with Databases] – [Creating a Custom Compatibility Mode] を参照してください。

互換性FIXを使用したテスト

互換モードを使用してテストした結果、アプリケーションのすべてまたは一部の問題点が修正されなかった場合は、互換性 FIX を使用してテストを行います。ただし、互換モードを使用して一部の問題点が修正された場合は、その互換モード （または互換モードをカスタマイズした互換性 FIX） を適用した状態でこのテストを行います。

互換性 FIX の選択方法

互換性 FIX は 200 近く存在するため、問題点の現象からテストの対象とする互換性 FIX を判断します。

このため、Application Compatibility Toolkit 3.0 では、従来の Windows 用に作成されたアプリケーションで発生すると考えられる互換性の問題点と、その問題点に対応する互換性 FIX の一覧表がカテゴリ別に用意されています。たとえば、「ファイル入出力」 のカテゴリにある 「アプリケーションから返されるディスクの空き容量の値が不正である」 という問題に対しては、互換性 FIX  「EmulateGetDiskFreeSpace」 が対応するとされています。

この問題点のカテゴリは、次の表 3のように分類されています。

表 3　問題点のカテゴリ
	カテゴリ
	概要

	16-Bit アプリケーション
	16-Bit アプリケーションに問題が発生した場合

	アプリケーションの削除
	アプリケーションが正しく削除できない場合

	クリップボード
	コピーや貼り付けの操作中にクリップボードに問題が発生する場合

	カラーパレット
	カラーパレットに問題がある、またはアプリケーションのウィンドウのコンポーネントが異なる色で表示される場合

	ディスプレイ
	画面の解像度や画面の色が正しくないなど、画面の表示に問題が発生する場合

	アプリケーションの実行
	アプリケーションの実行中に問題が発生する場合

	アプリケーションの終了
	アプリケーションの終了時にアクセス違反が発生する場合

	ファイル入出力
	アプリケーションにファイルアクセスの問題が発生する場合

	フォーカス
	アプリケーション上のフォーカスが正しく動作しない場合

	グラフィック コントロール
	アプリケーション上の画像の項目が正しく表示されない場合

	インストール
	アプリケーションのインストールに問題が発生する場合

	キーボード入力
	キーボードからの入力や特定のキーシーケンスにより問題が発生する場合

	マルチメディア
	サウンド、グラフィック、アニメーション、およびビデオに問題が発生する場合

	ネットワーク接続
	ネットワーク接続に問題が発生する場合

	パーミッション (権限)
	アクセス権限に関する問題が発生する場合

	印刷
	印刷が正しく機能しない場合

	レジストリ
	不正なレジストリ エントリによって問題が発生する場合

	スタート メニューおよびショートカット
	スタート メニューやショートカットが作成されない、または動作しない場合

	スタートアップ
	アプリケーションの起動時やプロセスの初期化時に問題が発生する場合

	TAPI (テレフォニー API)
	電話のダイヤラが正しく機能しない場合

	バージョン
	アプリケーションが別の Windows のバージョンを要求する場合

	ウィンドウ管理
	アプリケーションのウィンドウが正しく動作しない場合

	その他
	これらのカテゴリに該当しない問題点


これらのカテゴリを利用して、200 近く存在する互換性 FIX から、アプリケーションの各問題点に適用する互換性 FIX を絞り、テストを行います。ただし、場合によっては複数のカテゴリを使用する必要がある場合があります。たとえば、「アプリケーションのウィンドウが正しく表示されない」 という問題点の場合は、「カラーパレット」 と 「ディスプレイ」 の 2 つのカテゴリについてテストするとよいでしょう。

また、各互換性 FIX の説明については、Compatibility Administrator 上から直接 (互換性 FIX の選択時に右側のペインの下側に表示される説明)、または Application Compatibility Toolkit 3.0 付属のヘルプで確認することができます。

問題点と対応する互換性 FIX の一覧表、および互換性 FIX の詳細については、以下を参照してください。

· Application Compatibility Toolkit 3.0 付属のヘルプ 「Microsoft Windows Application Compatibility 3.0 Reference」 の [Application Deployment Toolkit] - [Testing for and Resolving Compatibility Problems] - [Determining the Application Compatibility Fix to Apply]

· Application Compatibility Toolkit 3.0 のインストールフォルダの documents フォルダにあるファイル 「Planning and Testing for Application Deployment.doc」 の 「Testing for and Resolving Compatibility Problems」 の章にある 「Determining the Application Compatibility Fix to Apply」

· Application Compatibility Toolkit 3.0 のインストールフォルダのdocuments フォルダのファイル 「Symptoms.xls」

以下に互換性 FIX のテスト手順を説明しますが、対象のアプリケーションが 1 つのファイルで構成されている場合と、複数のファイルで構成されている場合で手順に少し違いがあるため、それぞれのテスト手順について次の 2 つに分けて説明します。

· アプリケーションが 1 つのファイルで構成されている場合

· アプリケーションが複数のファイルで構成されている場合

互換性 FIX のテスト手順 (アプリケーションが 1 つのファイルで構成されている場合)

以下にアプリケーションが 1 つのファイルで構成されている場合の互換性 FIX のテスト手順を示します。テストでは前述の 『テストのための準備』 で作成した互換データベースの .SDB ファイルを使用します。

44. Compatibility Administrator を起動し、『互換モードのテスト手順 (アプリケーションが 1 つのファイルで構成されている場合)』 の手順 1 から 3 までを行います。

45. [Compatibility Modes] のページが表示されます。互換モードでテストした結果、一部の問題点が修正された場合はその互換モードを選択します。問題点が修正されなかった場合は、[None] を選択します。選択したら、[次へ] をクリックします。
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46. [Compatibility Fixes] のページが表示されます。ここで、アプリケーションの問題点の現象から推測される互換性 FIX を選択します。選択したら、[Test Run] をクリックします。

[image: image40.png]‘Select compatibility fixes ta be applied far this program.

Gompatiity Fpas: Showssiested] [ gearat

Nome -
[ venoutissrresimedevcs

[ w0005 versontie

[ @wincoooversiontie

[ @ vinssversonLie

) @ ¥inEsecuceonditonic

[l —— -
[ winnTssPoversintie v

Saoteaseor13

&e )t ] [ ®r ] [(Ftn ]





47.  [Test run application] ダイアログが表示されるので、[Program] ボックスに正しくアプリケーションのファイルが表示されていることを確認し、[OK] ボタンをクリックしテストを実行します。他の互換性 FIX を試す場合は手順3の [Compatibility Fixes] のページで選択する FIX を変更し、テストを繰り返します。

ダイアログはこのページ以降も続きますが、この手順では互換性 FIX のテストのみを行うため、ここでテストを終了します。

ヒント

互換性 FIX にはコマンド ラインを指定するものがあります。指定する方法については後述の 『互換性 FIX にコマンド ラインを指定する方法』 を参照してください。

互換性 FIX のテスト手順 (アプリケーションが複数のファイルで構成されている場合)

以下にアプリケーションが複数のファイルで構成されている場合の互換性 FIX のテスト手順を示します。テストでは前述の 『テストのための準備』 で作成した互換データベースの .SDB ファイルを使用します。

48. Compatibility Administrator を起動し、『互換モードのテスト手順 (アプリケーションが複数のファイルで構成されている場合)』 の手順 1 から 3 までを行います。

49. [Compatibility Modes] のページが表示されます。互換モードでテストした結果、一部の問題点が修正された場合はその互換モードを選択します。問題点が修正されなかった場合は、[None] を選択します。選択したら、[次へ] をクリックします。

50. [Compatibility Fixes] のページが表示されます。ここで、アプリケーションの問題点の現象から推測される互換性 FIX を選択します。選択したら、[完了] をクリックしてダイアログを終了します。
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51. アプリケーションを構成するすべてのファイルに対して手順 1 から 3 を繰り返し、すべて同じ互換モードおよび互換性 FIX を適用します。

52. 『互換モードのテスト手順 (アプリケーションが複数のファイルで構成されている場合)』 の手順 6 から 8 と同様の手順でテストを行います。

53. 別の互換性 FIX をテストする場合は、手順 1 から 5 を繰り返します。ただし、アプリケーションを構成するすべてのファイルに対して同じ互換性 FIX を適用することに注意してください。

ヒント

互換性 FIX にはコマンド ラインを指定するものがあります。指定する方法については後述の 『互換性 FIX にコマンド ラインを指定する方法』 を参照してください。

互換性 FIX にコマンド ラインを指定する方法

互換性 FIX にはコマンド ラインを指定するものがあります。その場合、Compatibility Administrator を Expert Mode で起動することにより、互換性 FIX にコマンド ラインを指定できるようになります。Expert Mode で起動するには、コマンド ラインで “/x” を指定します。ここでは、demoapp.exe で発生するデバッグエラーメッセージを修正する方法を例にとって、互換性 FIX にコマンド ラインを指定する方法を説明します。

54. Compatibility Administrator をコマンド ライン “/x” を指定して起動し、『互換モードのテスト手順』 の手順 1 から 4 までを行います。
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55.  [Compatibility Fixes] のページが表示されます。ここで、互換性 FIX に対してコマンド ラインを指定できます。コマンド ラインを指定する互換性 FIX を選択して [Parameters] をクリックします。ここでは、IgnoreMessageBox を選択します。
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56. 選択した互換性 FIX のオプション画面が表示されます。[Command Line] ボックスに、指定するコマンド ラインを入力し、[OK] ボタンをクリックします。
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57. 指定したコマンド ラインの値が [Command-line] の列に表示されていることを確認します。この状態で [Test Run] をクリックすると、選択した互換性 FIX にコマンドラインが指定された状態でアプリケーションをテストすることができます。
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ヒント
サンプルアプリケーション demoapp.exe には複数の互換性の問題点が含まれています。これらの問題点と対応する互換性 FIX については、”Application Compatibility Toolkit 3.0 インストールフォルダ\Applications\Compatibility Administrator” にある demoapp.txt に説明があります。互換性 FIX を適用する例として参考にして下さい。

互換性 FIX を使用したテストの終了

アプリケーションに対するテストは、この互換性 FIX を使用したテストですべて終了です。

テストした結果、問題点が解決された場合は次に 『互換データベースの作成と配布』 に進み、対象のアプリケーションに適用する互換モードおよび互換 FIX を別のコンピュータに配布するためのファイルを作成します。

問題点が解決されなかった場合は、そのアプリケーションは互換性がないと判断しテストを終了します。またこの場合、必要に応じてアプリケーションの問題点をユーザーに通知するためのメッセージを作成することができます。方法については次の 『AppHelp の作成』 を参照してください。

AppHelp の作成

Compatibility Administrator では互換性問題が解決できない場合に、最後のオプションとして AppHelp メッセージがあります。AppHelp メッセージにより、システムを不安定にしたり、他のアプリケーションに悪影響を与えたりするアプリケーションを実行しないようにユーザーに通知することができます。AppHelp メッセージは、アプリケーションの実行を禁止するか、またはアプリケーションを実行する前にメッセージを表示します。たとえば、 AppHelp メッセージによって、アプリケーションにパッチが必要であることをユーザーに通知し、パッチがある Web サイトの URL を提供することができます。

AppHelp メッセージは、互換性問題を解決するのではなく、アプリケーションが互換性問題を持っていることをユーザーに通知したり、アプリケーションを使用しないように警告するだけです。したがって、AppHelp メッセージは、アプリケーションの互換性問題に対して他に解決法がない場合や、アプリケーションが現在の Windows XP 環境上で必ずしも正しく実行できるとは限らない場合に使用することをお勧めします。また、AppHelp メッセージによってアプリケーションの実行を禁止するかどうかには関係なく、実行した結果の可能性とパッチの入手先に関する情報を提供することをお勧めします。

AppHelp メッセージを作成する手順を以下に示します。

AppHelp メッセージの作成手順

58. Compatibility Administrator で、AppHelp メッセージを追加するデータベースをクリックします。新規にアプリケーションを指定して AppHelp メッセージを追加する場合は、ツールバーの [AppHelp] をクリックします。または、既存のアプリケーションに AppHelp メッセージを追加する場合は、アプリケーションをクリックして [Edit] メニューの [Modify] をポイントして [Add an AppHelp Message] をクリックします。

· 新規にアプリケーションを指定して AppHelp メッセージを追加する場合
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· データベース中の既存のアプリケーションに AppHelp メッセージを追加する場合
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59. [Add a custom AppHelp Message] ダイアログが表示され、ここにアプリケーションの情報を入力します。アプリケーション名、ベンダー名、アプリケーションのファイルのロケーションを入力します。入力したら [次へ] をクリックします。
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60. アプリケーションを AppHelp メッセージに関連させるためにマッチングファイルを選択します。これはアプリケーションを一意に識別するためのファイルを指定します。たとえば、 .exe ファイルと同じディレクトリに保存される .hlp ファイルなど、対象となるアプリケーションに関連付いたファイルを選択します。選択したら [次へ] をクリックします。
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61. メッセージタイプを選択します。メッセージを表示した後にアプリケーションを実行するかどうかを指定します。[Display a message and allow this program to run] は、アプリケーションの実行が可能です。[Display a message and do not allow this program to run] は、アプリケーションの実行を禁止します。
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62. メッセージと、必要であればパッチがある Web サイトや、情報として提供したいサイトの URL を入力します。
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63. [Test Run] をクリックすると、AppHelp メッセージを表示させてアプリケーションの実行をテストできます。
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ヒント
手順７の画面で URL を入力すると、[詳細] が使用可能になり、クリックすると指定されたサイトが表示されます。
64. よければ [完了] をクリックしてダイアログを終了します。
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65. ツールバーの [Save] をクリックして保存すると、互換データベースに変更内容が追加されます。
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ヒント
右のペインの AppHelp をクリックすると画面下に、設定したメッセージの内容が確認できます。
互換データベースの作成と配布

アプリケーションのテストが終了し、適用するべき互換モードおよび互換性 FIX が決定したら、最後にその互換モードおよび互換性 FIX を他の Windows XP コンピュータに配布します。

ここでは、Compatibility Administrator を使用して、互換モードおよび互換性 FIX を１つの互換データベースとしてパッケージ化し、他の Windows XP コンピュータに配布する方法を説明します。

この互換データベースには複数のアプリケーションに対する互換モードおよび互換性 FIX をパッケージすることができるため、複数のアプリケーションに対して複数の互換データベースを配布して保守する手間が軽減されます。

互換データベースの作成

ここでは互換データベースを作成するアプリケーションの例として、Application Compatibility Toolkit 3.0 に付属しているサンプルアプリケーションの demoapp.exe を使用します。

以下に互換データベースの作成手順を示します。

66. 前述の 『Compatibility Administrator を使用したテスト』 の 「テストのための準備」 にある 「.SDB ファイルの作成」 の手順に従い .SDB ファイルを作成します。次に、作成した .SDB ファイルを選択した状態で、ツールバーの [Fix] をクリックします。または [Database] メニューの [Create New] をポイントし、 [Application Fix] をクリックします。
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67. [Create new Application Fix] ダイアログが表示されるので、アプリケーション名、ベンダー名、対象となるアプリケーションのファイル名を入力します。[Browse] をクリックしてファイルを参照することも可能です。ここでは [Browse] をクリックして ”C:\Program File\Compatibility Demo\demoapp.exe” を参照します。 [次へ] をクリックします。
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68. 適用する互換モードをクリックします。互換モードを指定しない場合は、[None] をクリックします。互換モードを適用した状態でアプリケーションをテストする場合は [Test Run] をクリックします。必要ない場合は [次へ] をクリックします。
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69. 互換性 FIX の編集をします。追加する FIX のチェックボックスをオンに、削除する FIX のチェックボックスをオフにします。 [Show Selected] をクリックすると、選択している FIX のみ表示できます。選択したら、[次へ] をクリックします。
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70. アプリケーションを一意に識別するためのマッチングファイルを指定します。たとえば、 .exe ファイルと同じディレクトリに保存される .hlp ファイルなど、対象となるアプリケーションに関連付いたファイルを選択します。選択したら、[完了] をクリックし、ダイアログを終了します。
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Windows XP は、このマッチング情報を使用してファイルを識別しています。そのため、仮に Setup.exe の互換性 FIX を作成する場合、対象以外の Setup.exe というファイルを実行するたびに、この互換性 FIX が適用されるのを防ぐ場合は、対象のアプリケーションに属する他のファイルを指定します。これらのファイルの特定のプロパティのデータを収集することにより、Windows XP では互換性 FIX を適用するべきアプリケーションを識別することができます。

注意
不必要に多くのマッチングファイルを指定せずに、ファイルを一意に特定することをお勧めします。
ファイルが一意に識別できない場合、同じ名前のファイルすべてに互換性 FIX が適用される可能性があります。
71. ツールバーの [Save] をクリック、または [File] メニューの [Save] をクリックして、変更を保存します。これで .SDB ファイルに互換性 FIX が追加されました。
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ヒント
一度 .SDB ファイルを作成した後でアプリケーションに適用する互換性 FIX や、マッチングファイルを修正するには、以下の手順で行います。

アプリケーションのファイル名を選択し、[Edit] メニューの [Modify] をポイントし、 [Edit Application Fix] をクリックするか、または右クリックのメニュー [Edit Application Fix] をクリックします。


この手順を実行後、[Edit Application Fix] ダイアログが表示され、その後は .SDB ファイルの作成と同様の手順で設定することにより修正できます。

互換データベースの配布

互換データベースを作成したら、次は各コンピュータへ配布を行います。

互換データベースを作成しただけでは、互換性 FIX はアプリケーションに適用されません。あくまで Compatibility Administrator 上で実行する場合だけです。そのため、互換データベースを各コンピュータに配布してインストールすることで、互換性 FIX をアプリケーションへ適用します。

配布するにはいくつかの方法がありますが、ここではログオンスクリプトを使用して配布する方法で、 Active Directory® を使用して、サイト、ドメイン、または組織単位 (OU) に対して割り当てる方法について説明します。

ログオンスクリプトを割り当てる手順を、以下のプロセスに分けて説明します。

· .SDB ファイルの配置

· ログオンスクリプトの作成

· ログオンスクリプトの配置

· ログオンスクリプトの割り当て

.SDB ファイルの配置

まず、サーバー上に共有フォルダを作成し、配布する .SDB ファイルを格納します。 .SDB ファイルをインストールするユーザーに対して、フォルダのアクセス権を読み取りに設定します。ここでは仮に、共有フォルダ名を "common" とします。
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ログオンスクリプトの作成

割り当てるログオンスクリプトに、Sdbinst.exe を使用して .SDB ファイルをインストールするためのコマンドを追加します。Sdbinst.exe の構文は以下のとおりです。

構文

sdbinst.exe [-?] [-q] [-u] [-g] [-n] Application Compatibility Database | GUID | Internal Application Name

表 4　sdbinst.exe のパラメータ
	パラメータ
	説明

	-q
	インストール時に指定します。このパラメータを指定すると、インストール中に表示されるメッセージがすべて非表示となります。

	-u
	アンインストールします。通常は使用しません。同じ互換データベースの新しいバージョンをインストールするたびに、古いバージョンは自動的にアンインストールされるからです。このパラメータは強制的に互換データベースを削除したい場合に使用します。

	-g
	互換データベースの GUID を指定してアンインストールする場合に使用します。

	-n
	互換データベースの内部ファイル名を指定してアンインストールする場合に使用します。

	Application Compatibility Database 
	インストール、またはアンインストールしたい .SDBファイル名です。

	GUID
	互換データベースのグローバル一意識別子(GUID)です。-g パラメータを使用してアンインストールするときに指定します。

	Internal Application Name
	互換データベースの内部ファイル名です。-n パラメータを使用してアンインストールする時に指定します。これは、互換データベースを Compatibility Administrator で作成したときに与えられた名前です。

	-?
	Sdbinst.exe のヘルプを表示します。


たとえば、サーバー上の共有フォルダ common に配置した .SDB ファイル mydb.sdb をインストールする場合は、次のようなコマンドを使用します。

コマンド例

sdbinst.exe -q \\server\common\mydb.sdb
ここでは、このコマンドを記述したファイルを、LogOn.bat と名前をつけて保存します。

ヒント
Sdbinst.exe は、Windows XP の既存のインストール内容に含まれているツールです。

ログオンスクリプトの配置

ログオンスクリプトをユーザー単体に割り当てる場合と、グループポリシーを使用してサイト、ドメイン、組織単位(OU) に割り当てる場合の、ファイルの配置先について説明します。

ログオンスクリプトをユーザー単体に割り当てる場合は、サーバー上にあるsystemroot\SYSVOL\sysvol\DomainName\Scripts フォルダに格納します。
グループポリシーを使用して、ログオンスクリプトをサイト、ドメイン、組織単位(OU) に割り当てる場合は、 [グループポリシーオブジェクトエディタ] > [ユーザーの構成] > [Windows の設定] > [ログオンスクリプト] の [プロパティ] を開いて [ファイルの表示] をクリックして表示されたフォルダにそれぞれ格納します。

ヒント
サーバー上の systemroot\SYSVOL\sysvol\DomainName\Scripts フォルダは、NETLOGON という名前で共有されます。
ログオンスクリプトの割り当て

Active Directory 環境でログオンスクリプトを割り当てるには、以下の操作を行います。

· ログオンスクリプトをユーザー単体に割り当てる場合

72. [スタート] > [管理ツール] > [Active Directory ユーザーとコンピュータ] をクリックします。
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73. [User] をクリックします。
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74. ログオンスクリプトを割り当てたいユーザーをクリックし、[操作] メニューの [プロパティ] をクリックして [プロパティ] を表示します。
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75. [プロファイル] タブをクリックします。
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76. [ログオンスクリプト] ボックスに、割り当てたいログオンスクリプトのファイル名を入力します(ここではファイル名を “LogOn.bat” とします)。
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77.  [OK] をクリックします。これで次回ドメインにログオンした時にログオンスクリプトが実行され、 .SDBファイルがインストールされます。

· グループポリシーを使用してログオンスクリプトを割り当てる場合

78. [スタート] > [管理ツール] > [Active Directory ユーザーとコンピュータ] をクリックします。

79. ログオンスクリプトを割り当てたいサイト、ドメイン、組織単位(OU) のいずれかをクリックし(ここでは組織単位の [User_OU] を選択します)、[操作] メニューの [プロパティ] をクリックして [プロパティ] を表示します。
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80. [グループポリシー] タブをクリックします。
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81. 新規にグループポリシーオブジェクトを作成してリンクする場合は、[新規]をクリックします。
すると、[新しいグループポリシーオブジェクト] が作成されます。ここでは名前を “New_GPO” と付けます。
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82. 既存のグループポリシーオブジェクトをリンクさせる場合は、[追加] をクリックします。
[グループポリシーオブジェクトのリンクを追加します] ダイアログが表示されるので、リンクさせたいグループポリシーオブジェクトをクリックし、[OK] をクリックします。ここでは、[すべて] タブで表示される、”New_GPO” を選択します。

[image: image70.png])

EEEEZIY
Fadu/ou| #4k 3AT |

B0 [Brendomainiocal
CORMUCIRENTOBINTOIN =T RIY = ATIabk

ExT

"S5 Default Damain Cartralers Policy
'S5 Default Damain Policy

st





83. グループポリシーオブジェクトをリンクさせたら、[グループポリシー] タブ中にある [編集] をクリックして、[グループポリシーオブジェクトエディタ] を開きます。
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84. [ユーザーの構成] > [Windows の設定]  > [スクリプト(ログオン/ログオフ)] をクリックします。
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85. [ログオン] の [プロパティ] を表示し、[追加] をクリックして割り当てたいログオンスクリプトを指定します。ここでは “LogOn.bat” を指定します
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86. [OK] をクリックします。これで次回ドメインにログオンした時にログオンスクリプトが実行され、 .SDBファイルがインストールされます。

.SDB ファイルのコンピュータへのインストールが完了したら、互換モードおよび互換性 FIX はアプリケーション起動時に常に適用されます。

ヒント
ログオンスクリプトの割り当てを行う前に、スクリプトをテストし、正しく .SDB ファイルのインストールが行われるか確認します。

おわりに

Windows XP には、アプリケーションの互換性に関するさまざまな技術が組み込まれており、[互換性] タブやプログラム互換性ウィザードを通してこれらの機能を使用することができます。

Windows XP 環境へのアプリケーションの移行プロセスにおいては、これらの [互換性] タブやプログラム互換性ウィザードに加え、Application Compatibility Toolkit 3.0 に含まれるツール Compatibility Administrator を使用して、アプリケーションの互換性に関するテストと問題点の解決を行います。

また、Compatibility Administrator は互換性に関するテストを行うだけでなく、問題点の解決に必要な互換性データベースを、他のクライアント コンピュータに配布することができます。

この文書は、Compatibility Administrator を使用した、Windows XP 環境へのアプリケーションの移行プロセスに焦点を当てて説明していますが、アプリケーションの展開における計画からテストまでの全体のプロセスについて、Application Compatibility Toolkit 3.0 付属のヘルプ、およびドキュメント "Planning and Testing for Application Deployment.doc" を参照することをお勧めします。

関連リンクと参考資料

最新の Application Compatibility Toolkit のダウンロードおよび互換性問題の詳細については、以下のリソースを参照してください。

· http://www.microsoft.com/japan/winlogo/downloads/software.asp の Windows ロゴプログラム – ソフトウェア用ダウンロードページ
互換性問題のテストおよび互換データベースの配布の詳細については、以下を参照してください。

· Application Compatibility Toolkit 3.0 のインストールフォルダの documents フォルダにあるファイル 「Planning and Testing for Application Deployment.doc」 の 「Testing for and Resolving Compatibility Problems」 - 互換性に関する問題の解決

· Application Compatibility Toolkit 3.0 のインストールフォルダの documents フォルダにあるファイル 「Planning and Testing for Application Deployment.doc」 の 「Deploying and Distributing Applications and .Sdb Files」 - アプリケーションおよび .sdb ファイルの展開と配布

互換性の問題点と対応する互換性 FIX の一覧については、以下を参照してください。

· Application Compatibility Toolkit 3.0 のインストールフォルダの documents フォルダにあるファイル 「Symptoms.xls」 

サンプルアプリケーション demoapp.exe の詳細については、以下を参照してください。

· Application Compatibility Toolkit 3.0 のインストールフォルダの Applications フォルダの Compatibility Administrator フォルダにあるファイル 「demoapp.txt」 
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